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Complimenti per l’acquisto della macchina fotografica Bushnell® Outdoor per l’uso 
all’aperto! La serie Outdoor è stata realizzata in particolare per scattare le migliori foto 
ricordo all’aperto: è impermeabile, è protetta contro la polvere e gli urti, ed è rivestita 
in gomma per assicurare una presa sicura.  Naturalmente, grazie al flash automatico e 
alla messa a fuoco ravvicinata, permette di fare foto favolose anche al chiuso. 

Prima di usare questa macchina fotografica si prega di leggere le istruzioni riportate in 
questo manuale e acquisire familiarità con i suoi vari componenti e caratteristiche.

 

GUIDA RAPIDA: MACCHINA FOTOGRAFICA OUTOODR BUSHNELL 11-0013G/Y

1 Inserire le pile e 
(se lo si desidera) 
la scheda della 
memoria

Inserire 2 pile alcaline AA o al litio, a seconda di ciò che è specificato nello scomparto pile in fondo 
alla macchina fotografica. Se si desidera ulteriore memoria per scattare un numero maggiore di foto, si 
può installare la scheda SD (optional), nell’apposito slot interno avendo cura di inserirla in modo che 
l’angolo provvisto di tacche si trovi a sinistra, verso il display LCD.

2 Accendere la  
macchina 
fotografica 

Premere il pulsante di accensione. Si possono iniziare a scattare le foto quando sull’LCD si iniziano a 
vedere le immagini dal vivo. Le impostazioni predefinite permettono di fare foto di qualità ottima nella 
maggior parte delle situazioni. Tuttavia si raccomanda di leggere l’intero manuale per sfruttare appieno 
le varie funzionalità utilizzabili in base alle condizioni ambientali e alle preferenze dell’utente.   

3 Impostare la 
lingua dei menu, 
la data e l’ora

Premere il pulsante OK/Menu e poi la freccia destra per aprire il menu Modalità. Premere due volte 
la freccia Giù per evidenziare “Set” (Imposta), e poi usare la freccia Destra per navigare l’elenco delle  
voci del menu Imposta. Scendere fino a “Language” (Lingua) e poi premere la freccia destra.  
Selezionare la lingua desiderata e poi premere il pulsante OK. Sul display riappare il menu Set  
(Imposta). Continuare a premere la freccia Giù fino ad evidenziare la voce “Date & Time” (Data e 
Ora) (andare oltre “File Name”, ovvero Nome File), e poi premere la freccia destra. Nella schermata 
Date & Time usare la freccia destra o sinistra per selezionare ciò che si desidera modificare, e poi usare 
la freccia su/giù per impostare data ed ora. La lettera in fondo alla riga della data specifica il formato (il 
primo è A/M/G). L’ora può essere impostata secondo il formato di 12 o 24 ore. Premere OK quando 
si è finito di impostare data ed ora.

4 Formattazione 
della scheda SD 
(optional)

Se si è inserita una scheda SD, occorre formattarla prima di usare la macchina fotografica. Andare alla 
voce “Format” (Formato) del menu Set (Imposta), e premere la freccia destra. Spostare il cursore su 
“Yes” (Sì) e poi premere OK per confermare che si desidera formattare la scheda. Premere OK se si 
desidera uscire da tutti i menu.

Si tenga presente che pur essendo impermeabile (grado di impermeabilità JIS-4), 
questa macchina fotografica non va usata sott’acqua, né sommersa o lavata con  
forti getti d’acqua. I danni causati dall’uso scorretto del prodotto non sono coperti 
dalla garanzia. 
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7. Monitor LCD 15. Pulsante Visione rapida

8. Pulsante di accensione. 16. Presa per treppiede 

9. Mirino 17. Barretta per cinghia

10. Tastierino a 4 vie

11. Pulsante OK / Menu

12. Coperchio scomparto pile

13. Pile (AA x 2)

14. Slot scheda SD

GUIDA RAPIDA: MACCHINA FOTOGRAFICA OUTOODR BUSHNELL 11-0013G/Y

5 Fotografare Premere fino a metà l’otturatore, il pulsante dello scatto, per impostare la messa a fuoco automatica 
(la spia verde AF si accende). Quindi, premerlo fino in fondo quando si è pronti a scattare la foto. Le 
linee dell’inquadratura al centro dell’LCD indicano la zona usata per impostare la messa a fuoco. Se 
alcuni elementi della foto sono fuori centro: inquadrare il soggetto principale, premere l’otturatore  
fino a quando la spia AF si accende; tenerlo premuto e spostare la macchina fotografica per  
ricomporre l’immagine desiderata. Quindi, premere fino in fondo il pulsante per scattare la foto.  
Questa macchina è completa di impostazioni predefinite per riprendere paesaggi, cose in  
movimento e ritratti. Vedere il paragrafo intitolato “Il menu Modalità” per informazioni dettagliate.

6 Controllo ed 
eliminazione  
di foto

Premere (tenere premuto) “Quick View” (Visione rapida) per vedere le foto in memoria. La  
freccia destra/sinistra permette di navigare avanti/indietro tra le foto. Le frecce su/giù permettono 
di zoomare avanti e indietro per vedere da vicino i dettagli desiderati delle foto. Per cancellare una 
foto durante la visione di controllo è sufficiente premere brevemente il tasto “Quick View” (Visione 
rapida) (il sistema visualizza l’icona del cestino dei rifiuti). Premere la freccia Giù, se si desidera  
rispondere Sì. Poi, premere OK per confermare che si desidera cancellare la foto. Per uscire  
dalla modalità di visione delle foto occorre premere e tenere premuto il pulsante Quick View  
(Visione rapida).

7 Collegare la 
macchina a un 
computer per 
trasferirvi le foto

Prima di collegare la macchina fotografica al computer occorre installare i driver dal CD-ROM, se 
si dispone del sistema operativo Windows 98/98SE, e poi PhotoSuite a meno che non si disponga 
già di un software di elaborazione delle immagini. Montare il cavo USB in dotazione collegandolo 
al PC e alla porta USB situata sotto il coperchio del connettore (sopra la cinghia). Premere “OK” 
sulla macchina fotografica. Se si ha il sistema operativo Windows XP, seguire le istruzioni/opzioni 
visualizzate sullo schermo. Se si ha Win 98 o 2000, aprire “Risorse del computer” sul proprio PC. La 
macchina fotografica viene rilevata come “Disco rimovibile”. Cliccare due volte su “disco” e aprire 
la cartella visualizzata al suo interno. Selezionare uno o tutti i file “.jpg” e usare “Modifica >Sposta 
(o Copia) nella cartella” se si desidera salvare le foto nella cartella “Le mie foto”, o in un’altra, sul 
proprio disco fisso. Dopo aver trasferito le foto si può scollegare la macchina fotografica ed aprire, 
modificare e salvare di nuovo i file usando PhotoSuite oppure un qualsiasi altro software fotografico. 
Per ulteriori dettagli si rimanda al paragrafo “Scaricamento delle foto passo per passo”.

Componenti

1. Otturatore (scatto)

2. Mirino

3. Flash

4. Coperchio connettore

5. Obiettivo

6. Spia del timer automatico
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Icone dell’LCD # Indicator Icone

6 Data visualizzazione 2004.06.20

7 Qualità immagine (compressione) FQ / NQ / EQ 

8 Dimensioni immagine 
(risoluzione)

2048x1536, 1600x1200, 1280x960, 
1024x768, 800x600   

9 Barra zoom digitale
 

10 Timer automatico
  

11 Macro

12 Ripresa sequenza (3 inquadrature)

13 Modalità fi lm

14 Bilanciamento del bianco

15 Schema metrico Media           centro

16 Impostazione ISO AUTO ISO100 ISO200 ISO400

17 Valore esposizione (VE) -2 ~ +2

18 Indicatore area AF

Inserimento pile 

Inserimento della scheda SD 

Far scorrere l’interruttore verso la presa del treppiede, come illustrato 
a destra, e quindi aprire il coperchio dello scomparto pile. Inserire 
2 pile alcaline AA nella macchina fotografi ca, come nell’illustrazione, 
e poi chiudere il coperchio fi no a quando si sente lo scatto di chiusura.

Questa macchina fotografi ca permette di conservare da 10 a 271 foto 
nella memoria interna da 16 MB, a seconda della risoluzione e delle 
impostazioni qualitative scelte (vedere la tabella sul retro del manuale). 
Per aumentare la memoria della macchina fotografi ca si può aggiungere 
una scheda SD (“Secure Digital”) con una capacità fi no a 512 MB. La 
scheda va inserita nell’apposito slot all’interno dello scomparto pile come 
illustrato nell’ultima fi gura. Notare che l’angolo con le “intaccature” 
è a sinistra, mentre i connettori di metallo sono rivolti verso l’alto.

# Indicatore Icone

1 Controllo carica pile

2 Modalità di scatto (soggetto)

3 Modalità fl ash AUTOM.

4 Scheda SD inserita “SD”

5 N. di foto restanti [ 999]
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Fotografare
Per accendere la macchina fotografica occorre tenere premuto il pulsante di accensione 
per 2 secondi. Appare la schermata di avviamento dello schermo LCD e l’indicatore 
di carica rosso lampeggia per qualche istante. Quando si vede l’immagine dal vivo (1), 
la macchina è pronta per l’uso. Comporre la foto desiderata sul display LCD (oppure 
usare il mirino se l’LCD non permette di vedere bene o se la carica delle pile è bassa).  
Premere l’otturatore fino a metà per avviare la messa a fuoco automatica sull’area  
centrale indicata dalle linee AF (2). Terminata la messa a fuoco, la spia verde AF  
accanto al mirino si accende e le linee rosse AF sull’LCD diventano verdi (si può fare la 
foto anche quando le linee sono ancora rosse, ma potrebbe risultare meno nitida). Per 
gli oggetti fuori centro, mettere a fuoco con la zona AF centrata sull’oggetto. Quindi, 
spostare la macchina fotografica come si desidera continuando a tenere premuto fino 
a metà l’otturatore. Premerlo fino in fondo quando si è pronti a scattare la foto (3). 
L’LCD visualizza brevemente la foto scattata (la durata della visualizzazione può essere 
modificata nelle impostazioni del menu Mode, cioè Modalità). Se si desidera spegnere 
l’LCD per risparmiare le pile, è sufficiente premere velocemente due volte il pulsante 
Quick View (Visione rapida) (se lo si tiene premuto, il sistema va in modalità Photo 
Review, ovvero Provini foto).

1

2 3

Zoom digitale
Premere il tasto “T” (telefoto) sul  pannello delle frecce  per zoomare in avanti (digitalmente fino a 4 volte). Se si 
preme il tasto “W” (wide, ovvero ampio)   dopo aver iniziato l’ingrandimento (zoom in avanti) il sistema fa lo zoom  
indietro per tornare alle dimensioni normali. NOTA: se le impostazioni dello zoom digitale sono elevate, l’immagine  
osservata dal vivo sul display potrebbe sembrare “grezza” o morbida a causa dei limiti di elaborazione in tempo reale.  
L’immagine che si vede non è, però, della qualità dell’immagine che verrà memorizzata, come si potrà vedere durante la  
Visione rapida delle foto dopo averle scattate. Per avere la massima qualità e nitidezza occorre scattare la foto quando 
l’indicatore AF diventa verde, cioè quando la messa a fuoco è ultimata.

Il Flash

Messa a fuoco macro e timer automatico

Quando si accende la macchina fotografica l’impostazione predefinita è “Auto Flash” (Flash automatico), cioè il flash scatta 
solo quando è necessario, in situazioni a bassa luminosità. Se si preme il pulsante destro sul tastierino a 4 vie si possono   
selezionare le altre opzioni: Red-Eye Reduction   (riduzione occhi rossi, il flash scatta brevemente in anticipo per ridurre 
le dimensioni delle pupille), Flash On (fa scattare il flash anche in ambienti illuminati, utile per eliminare le ombre 
sul viso delle persone quando il sole è alle loro spalle), e Flash Off  (il flash non scatta neppure in ambienti scuri, utile 
nei musei o nei teatri dove è proibito usare il flash). L’icona che corrisponde all’impostazione attuale del flash è visualizzata 
sull’LCD (vedere “Le icone dell’LCD”). NOTA: Quando Auto Flash è impostato su “normale”, sull’LCD non appare alcuna 
icona. Dopo aver scattato una foto con il flash, occorre aspettare qualche secondo prima di poterne scattare un’altra affinché 
i circuiti del flash si ricarichino.

Inquadratura della zona  
di messa a fuoco automatica  

   La messa a fuoco macro (Macro Focus) permette di fotografare oggetti in primo piano, cioè a distanza  
ravvicinata, circa 10-60cm. Per impostare questa modalità occorre premere il pulsante sinistro del  
tastierino.   Il sistema visualizza il menu macro/timer sull’LCD. Quando l’icona della modalità macro 
(fiore) è evidenziata, premere “OK” per selezionarla. L’icona macro appare sull’LCD di visione delle foto. 
Quando si fanno le foto in modalità macro occorre tenere la macchina fotografica ben ferma e aspettare 
l’accensione della spia dell’Auto Focus. Per tornare alla modalità di messa a fuoco normale occorre premere 
il pulsante di sinistra, selezionare di nuovo macro e poi premere OK. 
    Una volta aperto il menu macro/timer è sufficiente premere la freccia Giù per evidenziare le opzioni del 
timer automatico. In questo modo è possibile includere sé stessi nella foto usufruendo della funzione di 
scatto ritardato di 3   o 10  secondi. Premere OK per selezionare il tempo desiderato. Montare la  
macchina fotografica su un treppiede o collocarla su una superficie robusta e piana e poi premere  
l’otturatore. Esso scatterà automaticamente alla fine del tempo prefissato. Il timer è utile anche per evitare di 
muovere la macchina fotografica mentre si fanno le foto di sera, dato che in ambienti scuri l’otturatore opera 
molto più lentamente. Per tornare alla modalità di funzionamento normale dell’otturatore occorre premere 
il pulsante di sinistra, selezionare il timer corrente e quindi premere OK. 
    Se si desidera uscire senza selezionare nulla, occorre premere Cancel (Annulla) quando sul display è  
visualizzato il menu macro/timer.

Menu 
Macro/
Timer  
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Uso dei menu superiori
Quando si preme il pulsante OK/Menu   situato sotto il tastierino delle frecce, 
sull’LCD appaiono i menu superiori. Vi sono 2 menu “Scorciatoia”, che permettono di  
modificare rapidamente le dimensioni e la qualità delle foto o di passare velocemente  
alla modalità film, e il menu Mode (Modalità) che contiene diverse impostazioni suddivise 
in gruppi o “schede”. Per accedere ad uno dei menu è sufficiente premere il pulsante del 
tastierino che punta in direzione dell’icona. Menu e funzioni:

Menu Icona Funzione
Modalità film

Modalità foto

        da modalità foto 
          
        da modalità film

Permette di passare dalla modalità foto alla modalità film per fare 
dei video (formato avi). Premere di nuovo la freccia “su” per passare 
dalla modalità film a quella per foto. 

Dimensioni e 
qualità delle 
immagini

Le dimensioni dell’immagine (file) possono essere ridotte da  
2048x1536 a 800x600 pixel in 5 operazioni. Le immagini di  
dimensioni maggiori hanno una risoluzione (nitidezza) superiore  
ma occupano più memoria.  La voce Image Quality (Qualità  
immagine) può essere impostata su “FQ” (qualità fine), “NQ” 
(normale) o “EQ” (economica). Ciò influisce sull’entità della 
compressione del file .jpg: con FQ si ha la minima compressione /  
massima qualità / massima dimensione del file. Se si impostano  
dimensioni inferiori e una qualità inferiore si utilizza meno memoria. 
Queste impostazioni sono utili quando si desidera fare stampati 
piccoli o inviare le foto per e-mail.  

Selezione dei menu  

Menu Icona Funzione
Modalità Apre ulteriori menu, come illustrato 

qui di seguito.

Uso dei menu superiori seguito

Il menu Modalità - ulteriori impostazioni

Schermata menu Mode 
(Modalità) con le colonne 
seguenti da sinistra, 
Group (Gruppo),  
Item (Voce), e Setting  
(Impostazioni). Usare 
il tastierino a 4 vie 
per spostare il cursore 
all’interno delle colonne.

Dopo aver premuto il pulsante OK/Menu per vedere i 3 menu superiori, 
usare il pulsante destro del tastierino per aprire il menu Mode (Modalità).  
Le voci del menu sono disposte in 3 gruppi, o schede, come illustrato  
nella colonna sinistra della schermata Mode Menu (Menu modalità). Per 
selezionare un determinato gruppo di menu, usare le frecce su/giù. Quindi,  
premere la freccia destra per passare alla seconda colonna dove sono  
riportate le voci del gruppo scelto. Usare di nuovo le frecce su/giù  
per spostare il cursore sulla voce desiderata. Quindi, premere la freccia 
destra per andare nella terza colonna e vedere le impostazione disponibili. 
Usare le frecce su/giù per selezionare l’impostazione desiderata. Quindi, 
premere il pulsante OK/Menu per confermare. Dopo aver selezionato le 
impostazioni, premere il pulsante OK/Menu fino a quando riappare la 
schermata normale. I gruppi del menu Mode, e i sottomenu delle loro 
voci/impostazioni, sono disposti nell’ordine seguente (le impostazioni  
predefinite sono in grassetto):

Nota: nel menu Size 
(Dimensioni) è riportato 
solo il primo numero.
2048 x 1536
1600 x 1280
1280 x 960
1024 x 768
800 x 600
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Il Menu Modalità - Gruppi / Voci / Impostazioni
Gruppo Voce Impostazioni Descrizione

1: Esposizione Soggetto P (Programma) Autoesposizione standard per foto normali

Paesaggio  
Zona di messa a fuoco più profonda per una maggior nitidezza dal primo piano 
allo sfondo.

Ritratto     
Zona bassa di messa a fuoco per immagini di persone. Aiuta ad isolare la persona 
dallo sfondo.

Azione      
L’otturatore opera a velocità maggiori per aiutare a riprendere la scena in il 
movimento.

Sera           
L’otturatore opera a velocità inferiori per migliorare l’esposizione in ambienti  
poco illuminati

Metro Centro La macchina fotografica determina l’esposizione basandosi principalmente sul 
centro dell’inquadratura. Utile in caso di notevole contrasto tra la luminosità del 
soggetto principale e quella dello sfondo.

Media La macchina fotografica sceglie l’esposizione in base all’immagine generale.  
Nessuna icona sull’LCD.

ISO Auto La fotosensibilità viene impostata automaticamente: ISO 100 ~400. 

100/200/400 Impostazioni manuali. Usare ISO elevati solo in caso di ambienti poco illuminati.

EV -2.0 ~ +2.0 Permette di regolare manualmente la sotto/sovraesposizione ad intervalli di 0,3 EV 

2: Colore WB Auto (A) Il bilanciamento del bianco viene impostato automaticamente per la riproduzione 
corretta dei colori.

Sole         Impostazione manuale per le giornate di sole all’aperto

Gruppo Voce Impostazioni Descrizione

Nuvoloso        Impostazione manuale per giornate nuvolose o zone all’ombra.

Tungsteno     
Impostazione manuale all’interno di locali in caso di illuminazione  
al tungsteno (lampadina).

Fluorescente    
Impostazione manuale in ambienti con illuminazione a base  
di lampadine fluorescenti.

Colore
Modalità

Colore Riproduzione normale dei colori

Bianco e nero Solo per fotografie in bianco e nero

Seppia Effetto speciale per foto “anticate”.

Contrasto Alto Contrasto potenziato per giornate nuvolose o luce a basso contrasto.

Normale Contrasto medio per la maggior parte dei soggetti.

Basso Contrasto ridotto per foto scattate a metà giornata o in altre condizioni  
di alto contrasto.

3: Imposta Resetta 
tutto

No / Sì Selezionare “Yes” (Sì) e premere il pulsante “OK/Menu” se si desidera  
cancellare tutte le impostazioni dell’utente e ripristinare quelle predefinite.

Formato No / Sì Selezionare “Yes” (Sì) e poi premere il pulsante “OK” per formattare  
(preparare) la scheda SD inserita (optional). Attenzione: tutti i file presenti 
sulla scheda verranno cancellati.

Il Menu Modalità - Gruppi / Voci / Impostazioni seguito
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Il Menu Modalità - Gruppi / Voci / Impostazioni seguito

Gruppo Voce Impostazioni Descrizione

3: Imposta Lingua Inglese/Spanish/
French/Deutsch/
Italiano/Portuguese

Permette di selezionare la lingua in cui verranno visualizzati i menu

Revisione 1, 2 o 3 secondi Imposta il tempo di revisione delle foto dopo lo scatto.

Nome file Resetta o serie La numerazione dei file delle foto nuove, dopo averle cancellate tutte,  
ricomincia da “1” (Resetta) oppure prosegue dall’ultimo numero usato (Serie)

Luminosità 
LCD 

Imposta uno dei 
7 livelli

Imposta la luminosità del display. Casella sinistra = minore luminosità, Casella 
destra = maggiore luminosità. Casella centrale = luminosità normale. Premere 
OK per confermare.

Data ed ora > per Impostazioni 
Premere OK quan-
do si ha finito.

Le frecce destra/sinistra permettono di navigare tra i vari campi. Le frecce 
su/giù permettono di cambiare le impostazioni. La lettera in fondo alla data 
definisce il tipo di formato: Prima M, G, o A.

Uscita video NTSC o PAL Influisce sul segnale di uscita del video impostato in conformità alla rete TV 
della località dell’utente.

Modalità 
registraz.

1 o 3 scatti Fissa il numero di foto che vengono fatte ogni volta che si preme l’otturatore. 
Se si sceglie 1-shot (1 foto), la macchina fa una foto normale, se si sceglie 
3-shot (3 foto) la macchina fa 3 foto, in rapida successione, per cogliere una 
sequenza di azioni.

Archiviazione Auto I file vengono memorizzati sulla scheda SD, se inserita, altrimenti sulla RAM interna.

Scheda SD I file vengono memorizzati solo sulla scheda SD (deve essere inserita).

Mem. interna I file vengono conservati soltanto nella memoria interna, non sulla scheda. 

Visione e cancellazione delle foto in memoria
Per vedere (playback) le foto nella memoria interna o sulla scheda SD occorre premere e tenere premuto il pulsante 
“Quick View” (Visione rapida) fino a quando sul display appaiono le foto fatte in precedenza. Utilizzare le frecce 
destra/sinistra per navigare da una foto all’altra. Durante la visualizzazione delle foto se si preme la freccia “Su” il 
sistema inizia a zoomare in avanti l’immagine (ingrandimento fino a 4 volte). Questa funzione è utile per verificare 
che la foto sia nitida.  Una volta ingrandita si può premere “OK” e poi usare il tastierino a 4 vie per osservare i vari 
particolari (premere di nuovo OK quando si desidera uscire). Dopo aver ingrandito la foto si può premere la freccia 
Giù per zoomare all’indietro. Se si preme la freccia Giù mentre la foto è visualizzata normalmente (non ingrandita) 
il sistema visualizza l’anteprima di varie foto (fino ad un massimo di 9 per volta). Il tastierino può essere usato per 
evidenziare una determinata foto che può, quindi, essere visualizzata a pieno schermo premendo il pulsante OK/ 
Menu. Se si desidera cancellare (eliminare) una foto durante la visione, è sufficiente premere brevemente (senza  
tenerlo premuto) il pulsante Quick View (Visione rapida). Il sistema visualizza il menu Delete (Cancella) e due 
scelte: One (Una) o All (Tutte). Premere la freccia Giù (seleziona “One”, ovvero Una), e poi OK, se si desidera  
eliminare soltanto tale foto. Mentre la foto viene cancellata, il sistema visualizza la “clessidra”. Notare che non  
appena si preme il pulsante OK dopo aver selezionato “One” (Una) o “All” (Tutte), le foto vengono cancellate 
immediatamente. Quindi, fare attenzione a non selezionare “All” (Tutte) prima di aver trasferito le foto nel PC.  
Quando si è finito di osservare le foto, premere e tenere premuto il pulsante Quick View (Visione rapida). Il display 
torna a visualizzare le immagini dal vivo. 

I menu di visione delle foto
Dopo aver premuto il pulsante Quick View (Visione rapida) per la modalità 
di Revisione, se si preme il pulsante OK/Menu si accede ai menu utilizzati per 
la visione/controllo delle immagini. Questi menu funzionano come illustrato 
nelle istruzioni riportate in precedenza per i menu della modalità Foto (le frecce 
del tastierino vengono usate per navigare fino al menu desiderato e il tasto  
OK per confermare le varie impostazioni). L’unica differenza sono le voci  
e le impostazioni seguenti:

Modalità Revisione:   
Menu superiori
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Menu Icona Funzione

Presentazione  Fa vedere, in sequenza, tutte le foto in memoria a partire da quelle con la data più vecchia. Premere 
la freccia Su per dare inizio alla presentazione. Il sistema si ferma dopo la visualizzazione della foto 
più recente e torna alla modalità di visione normale.

Informaz. Con questa voce si decide se visualizzare o meno i particolari di ciascuna foto (n. del file,  
dimensioni e qualità dell’immagine, data/ora) durante la modalità di visione. Non altera i dati  
in memoria.

Menu Modalità 
visione

Apre ulteriori impostazioni come illustrato nella sezione seguente.

I menu di visione delle foto seguito

Impostazioni, Menu Modalità Visione
Gruppo Voce Impostazioni Descrizione

1: Esegui Proteggi Off / On Se si imposta questa voce su “On” non sarà possibile cancellare le foto 
fino a quando non la si reimposta su “Off” tramite questo menu.  
Impedisce di cancellare i file per sbaglio.

Gira + o - di 90 gradi Ruota la visualizzazione della foto che si sta visionando. Evita di dover 
girare la macchina fotografica per vedere le foto riprese in verticale (per 
es. riprese di persone, ecc.). 

2: Colore Bianco e 
nero

Off / On Permette di creare un’ulteriore versione in bianco e nero (file nuovo) 
dalla foto che si sta visionando (occorre attendere solo qualche secondo). 
Tutto questo non altera il file della foto originale a colori.

Gruppo Voce Impostazioni Descrizione

Seppia Off / On Vedere descrizione per foto in bianco e nero. Tonalità color seppia.

Copia sulla scheda SD No / Sì Copia tutto il contenuto della memoria interna sulla scheda SD.

Formato No / Sì Formatta la scheda SD inserita e ne cancella tutto il contenuto.

3: Imposta Resetta tutto No / Sì Selezionare “Yes” (Sì) e premere il pulsante “OK/Menu” se si desidera  
cancellare tutte le impostazioni dell’utente e ripristinare quelle predefinite.

Lingua Vedere quanto descritto prima nella sezione Menu della modalità Foto.

Luminosità LCD Vedere quanto descritto prima nella sezione Menu della modalità Foto.

Data ed ora Vedere quanto descritto prima nella sezione Menu della modalità Foto.

Uscita video Vedere quanto descritto prima nella sezione Menu della modalità Foto.

Impostazioni, Menu Modalità Visione seguito

Modalità Film - funzionamento e menu
Nella modalità Foto con la visione dal vivo, premere OK/Menu per accedere ai menu superiori. Premere la freccia  
Su per passare alla modalità Film. Appare l’icona rappresentativa dei film / video.      Selezionare la risoluzione  
desiderata, “320” o “160”, premendo il tasto OK/Menu e poi la freccia sinistra. Per iniziare a riprendere il video  
(formato avi) è sufficiente premere l’otturatore. Per interrompere la ripresa basta premere di nuovo l’otturatore. Per  
vedere il video fatto è sufficiente tenere premuto Quick View (Visione rapida) fino a quando il display cambia a  
Review, ovvero Revisione (si vedrà il primo frame del film). Premere l’otturatore per iniziare a vedere il video.  
Premere brevemente Quick View (Visione rapida) per andare al menu Delete (Cancella).  Terminata la ripresa del 
video, premere OK per visualizzare il menu superiore e poi la freccia Su (icona della macchina fotografica) per tornare 
alla normale modalità Foto. Differenze nei menu/funzioni delle modalità Film e Foto:
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Requisiti del sistema (Minimo)

Installazione del software

Scaricamento delle foto - un passo alla volta

Sistema operativo: Windows® 98/98SE/2000/ME/XP
CPU: MMX Pentium® 200MHZ, equivalente o più veloce, (Pentium® III 500 MHz per PhotoSuite5™)
Memoria: almeno 32MB (si raccomandano 64MB per PhotoSuite)
Scheda video SVGA con 2MB di VRAM, display schermo da 800x600, colori 16 bit
200 MB di memoria libera sul disco fisso (se si installa PhotoSuite)
Porta interna USB

Se si ha Windows 98 occorre installare gli appositi driver prima di collegare la macchina fotografica al PC. Inserire il 
CD-ROM nell’unità CD del computer. Il CD viene letto automaticamente dal sistema che visualizza la schermata per 
l’installazione.  Selezionare “Install Driver” (Installa i driver) e quindi seguire le istruzioni sullo schermo. Dopo l’installazione 
occorre riavviare il computer. Se si ha Windows 2000, ME od XP non occorre installare i driver in quanto la macchina  
fotografica utilizza lo standard USB di archiviazione di massa e, di conseguenza, i file delle foto vengono letti come se  
fossero archiviati su un disco fisso esterno. Gli utenti Windows che non dispongono già di un software di elaborazione delle 
immagini possono installare Roxio PhotoSuite® dal CD-ROM. Non dimenticare di leggere attentamente le “Informazioni 
sulle release” prendendo nota di eventuali consigli o potenziali problemi riguardanti la propria configurazione PC e il proprio 
sistema operativo.

1. Gli utenti Windows 98/98SE devono, per prima cosa, assicurarsi che il driver sia installato.
2. Quindi, accendere la macchina fotografica e collegare il cavo in dotazione inserendolo nel jack 
USB della macchina fotografica (aprire il coperchio del connettore sul lato della macchina dove c’è la 
cinghia) e quindi nella porta USB principale del computer. Non usare le porte USB della tastiera o 
del pannello frontale o gli “hub” non alimentati.
3. Sul display della macchina fotografica appare la schermata di trasferimento con l’icona del PC 
evidenziata. Premere “OK”. Sul display appare la schermata “Mass Storage” (Archiviazione di massa). 
In caso contrario: chiudere tutti i programmi aperti, scollegare la macchina fotografica, riavviare il 
computer e ripetere l’operazione.

schermata
scaricamento    

Modalità Film - funzionamento e menu seguito 
Nella modalità Film, tutte le funzioni e le voci di menu sono identiche a 
quelle della modalità Foto salvo le eccezione seguenti:
• Mancano le regolazioni preimpostate per i soggetti (paesaggi, ritratti, ecc.)
• Mancano le voci Rec Mode (Modalità registraz.) (sequenza 3x).
•  Le dimensioni disponibili per le immagini sono 320x240 o 160x120. Questo permette di impostare la 

risoluzione del film di frame in frame. Se si imposta la risoluzione a 160x120 si aumentano di 4 volte  
i tempi di registrazione rispetto alla risoluzione 320x240, ma si riduce la qualità. L’impostazione predefinita 
è di 20 frame al secondo.

• Non sono disponibili i gradi di qualità (compressione file).
•  Prima di avviare la registrazione del video si possono vedere i secondi di registrazione restanti (31”, 124”, 

ecc.) sul contatore situato nell’angolo inferiore destro del display LCD.
• Durante la registrazione del video il contatore visualizza i secondi trascorsi.
• Lo zoom digitale e la messa a fuoco macro non sono disponibili. Il flash è impostato su “Off”.
•  Se la macchina fotografica viene spenta mentre è in modalità Film, quando la si riaccende è in modalità 

Foto. 
 
Nota: Se il PC dell’utente non esegue i file in formato .avi dei film in Windows Media Player, potrebbe essere  
necessario scaricare una versione più recente del software dal sito Microsoft.com (cercare le parole chiave “media 
player download”). I file del film possono essere eseguiti anche con QuickTime Player, che è in dotazione con tanti 
computer e può essere scaricato gratuitamente dal sito Apple.com.
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Uso della funzionalità di stampa diretta (Pictbridge)
La macchina fotografica Outdoor supporta anche la stampa diretta con stampanti compatibili  
PictBridge senza doversi collegare al PC. Si raccomanda di leggere il capitolo sulla stampa diretta/
PictBridge della stampante prima di effettuare l’operazione. Con la stampante accesa, collegare il 
cavo USB, in dotazione, alla macchina fotografica e poi alla porta USB per stampa diretta situata  
sulla parte frontale o laterale della stampante.  Il display della macchina fotografica dovrebbe  
accendersi (in caso contrario, accenderla manualmente). Selezionare l’icona della stampante (1),  
e premere “OK”. Dopo una breve attesa, durante la quale la macchina fotografica e la stampante 
effettuano la connessione, sul display appare il menu Print (Stampa) (2). Utilizzare le frecce su/giù 
per selezionare la voce desiderata e poi premere OK. Le voci sono (icone dall’alto verso il basso): 1

2

1. Stampa una foto (usare le frecce sinistra/destra per selezionare l’immagine desiderata e le frecce 
su/giù per selezionare il numero di esemplari che si desidera stampare.  Premere OK quando si 
desidera stampare).
2. Stampa tutte le foto (No/Sì) Stampa tutte le foto nella memoria della macchina fotografica.
3. Stampa la foto scelta durante la visione dei provini (usare la freccia destra/sinistra, per  
selezionare la foto desiderata, e le frecce su/giù per scegliere il numero di esemplari desiderato).
4. Stampa tutte le foto come indice: stampa i provini di tutte le foto (“strisce”)
5. Uscita dal menu di stampa.

4. Aprire Risorse del computer o Windows Explorer. Il sistema vede la macchina fotografica come se fosse un “Disco rimovibile” 
a cui è assegnata una lettera di identificazione univoca, non ancora assegnata ad altre unità. Cliccare due volte sull’icona nuova 
del “Disco”, aprire la cartella “DCIM”, e poi una qualsiasi cartella al suo interno (“100BUSHN”, ecc.). Le foto dell’utente 
sono i file JPEG situati all’interno della cartella - hanno il prefisso “BUSH__” seguito da un numero, il medesimo osservato sul 
display della macchina fotografica durante la visione delle foto. Se si clicca una volta su un qualsiasi file, il sistema ne mostra 
una piccola anteprima.
5. Cliccare su “Edit>Select All” (Modifica > Seleziona tutto) (oppure usare la combinazione control+clic se si desidera 
selezionare varie foto), poi su “Edit>Copy to Folder” (Modifica>Copia nella cartella) (nei menu di Windows). Selezionare una 
cartella già presente sul proprio disco fisso, ad esempio “Mie foto”, oppure creare una cartella nuova (“Ferie 2004”, ecc.) e poi 
cliccare su “OK” per trasferire le copie dei file delle foto desiderate.
6. Dopo il trasferimento delle foto sul disco fisso si può scollegare la macchina fotografica. Windows potrebbe visualizzare un 
messaggio di avvertenza in cui comunica che il dispositivo USB è stato scollegato senza aver prima fermato o estratto il “disco” 
(i file delle foto non saranno danneggiati). Nel caso, spuntare la casella che permette di aggiungere le icone sulla barra delle 
applicazioni o delle attività. La prossima volta che si trasferiscono le foto sul disco fisso sarà sufficiente cliccare sull’icona e 
“Fermare il dispositivo USB di archiviazione di massa” prima di scollegare la macchina fotografica.
7. A questo punto è possibile aprire i file delle foto con un qualsiasi software di elaborazione delle immagini fotografiche. 
Allo scopo basta selezionare File>Open (File>Apri) e quindi accedere alla cartella in cui si sono archiviate le foto. Se si utilizza 
PhotoSuite, selezionare File>Open Photo (File>Apri foto), e poi usare il menu a tendina “Look in” (Guarda dentro) nella 
parte superiore della finestra intitolata Open (Apri), selezionare “Risorse del computer”, selezionare il proprio disco fisso e poi 
cliccare due volte sulla foto desiderata nella cartella in cui si sono copiati i file dalla macchina fotografica. Si tenga presente che 
i file delle foto possono essere aperti direttamente anche dalla macchina fotografica Outdoor mentre è ancora collegata. Per 
effettuare l’operazione con PhotoSuite occorre, per prima cosa, fare le operazioni da 1 a 3, poi lanciare PhotoSuite, selezionare 
File>Open Photo (File>Apri foto) e quindi usare il menu “Look in” (Guarda dentro) per selezionare Risorse del computer, 
“Removable Disk” (Disco rimovibile) e poi aprire le cartelle che vi sono archiviate fino a quando si arriva ai file delle foto 
JPEG. Se si sceglie di lavorare in questo modo, cioè con la macchina fotografica collegata, occorre ricordarsi di salvare la foto 
(dopo aver fatto le modifiche) sul proprio disco fisso e non nella memoria o sulla scheda della macchina. Per effettuare questa 
operazione in PhotoSuite occorre, dopo aver cliccato su “Done” (Finito), rispondere “Yes” (Sì) alla domanda “Save Changes?” 
(Salva i cambiamenti?), e poi rispondere “No” alla domanda “Replace Existing File”? (Sostituire il file esistente?). Usare la 
casella di dialogo “Save As” (Salva con nome) per salvare la foto modificata in una cartella sul disco fisso (“Save In>Local Disk”, 
ovvero Salva su>Disco locale) , e non sul “Removable Disk” (Disco rimovibile) (che corrisponde alla macchina fotografica).
 

Scaricamento delle foto - un passo alla volta seguito Scaricamento delle foto - un passo alla volta seguito 
8. Se non si ha molta dimestichezza con le tecniche di ritocco delle foto su computer, consultare la Guida del software  
(PhotoSuite dispone di una Guida molto approfondita) per consigli sull’applicazione delle sue funzioni. Oltre a modificare 
la luminosità, il contrasto, la nitidezza e i colori delle foto, è possibile modificarne anche le dimensioni per adeguarle a quelle 
della carta su cui verranno stampate, oppure le si possono salvare in file a risoluzione inferiore per facilitarne la spedizione via  
e-mail o l’inserimento in documenti.  Quando si è pronti a salvare il file modificato, si consiglia di usare la voce “Save As” (Salva con 
nome) per assegnargli un nome più significativo di, ad esempio, “BUSH0001”. Così facendo si conserva anche il file originale come 
backup per eventuali modifiche successive.  Accertarsi di aver trasferito tutte le foto che si desidera salvare prima di selezionare, sulla 
macchina fotografica, “Delete All” (Cancella tutto) per fare spazio per la ripresa di immagini nuove.
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GARANZIA LIMITATA DI DUE ANNI

Questo articolo Bushnell® è garantito esente da vizi nei materiali e da difetti di fabbricazione  
per un periodo di due anni a decorrere dalla data di acquisto. In caso di difetti coperti dalla  
garanzia, la società si impegna, a propria discrezione, a riparare o a sostituire il prodotto  
speditole porto franco. Sono esclusi dalla garanzia i danni causati da utilizzo scorretto,  
maneggiamento / gestione impropri, installazione o manutenzione eseguiti da persone non 
autorizzate dal servizio assistenza Bushnell.

I prodotti coperti da garanzia vanno spediti unitamente a quanto segue:
 1)  Assegno/ordine di pagamento di $10,00$USA  per coprire i costi di spedizione  

e amministrazione.
 2) Nome e indirizzo del mittente.
 3) La spiegazione del difetto.
 4)   Scontrino riportante la data di acquisto.
 5)   Il prodotto deve essere imballato con cura in una scatola robusta per spedizioni per 

evitare danneggiamenti e spedito, debitamente affrancato, all’indirizzo seguente: 

Negli USA, spedire a:  IN CANADA, spedire a: 
Bushnell Performance Optics  Bushnell Performance Optics
Attn.:  Repairs   Attn.:  Repairs
8500 Marshall Drive  25A East Pearce Street, Unit 1
Lenexa, Kansas 66214, USA  Richmond Hill, Ontario L4B 2M9, Canada

I clienti che hanno acquistato il prodotto in un Paese diverso dagli Stati Uniti o dal Canada 
sono pregati di rivolgersi al rivenditore per le istruzioni del caso. In Europa si può anche 
contattare la Bushnell direttamente:
 BUSHNELL Performance Optics Gmbh
 European Service Centre
 MORSESTRASSE 4
 D- 50769 KÖLN
 GERMANIA
 Tel.: +49 (0) 221 709 939 3
 Fax: +49 (0) 221 709 939 8

La presente garanzia conferisce dei diritti legali ben precisi.
Il cliente può avere altri diritti che variano da una nazione all’altra.

©2004 Bushnell Performance Optics

Dimens. 
immagini

Megapixel 
(ca.)

Qualità * Memoria 
interna

Scheda SD 
da 64 MB 

2048x1536 3,2 FQ 10 foto 39 foto

NQ 20 79

EQ 41 158

1600x1280 2,1 FQ 16 64

NQ 33 129

EQ 67 259

1280x960 1,3 FQ 26 101

NQ 53 202

EQ 106 405

1024x768 0,8 FQ 41 158

NQ 82 317

EQ 165 634

800x600 0,5 FQ 67 259

NQ 135 519

EQ 271 1038

Riferimenti Capacità e Memoria (capacità max +/- 2 foto)

* Grado di compressione dei file (rapporto 
jpg)
(FQ=bassa/EQ=alta)
FQ: Qualità fine (1:2,5)
NQ: Qualità normale (1:5)
EQ: Qualità economica (1:10)

Per dimensioni dell’immagine si intendono le 
dimensioni in pixel, ovvero la risoluzione del 
file digitale. 
 
La capacità effettiva di archiviazione varia  
in relazione al contenuto del file di ciascuna  
foto. È possibile che si riesca a scattare qualche 
foto in più, o in meno, rispetto alla capacità 
media specificata. 

Scegliere le impostazioni per grandi  
dimensioni e alta qualità quando si prevede di 
fare ingrandimente o ritagli. All’occorrenza è 
possibile ridurre le dimensioni dei file usando 
il proprio software fotografico. Scegliere  
le impostazioni per piccole dimensioni e/o 
bassa qualità se si desidera inviare le foto  
per e-mail, inserirle in documenti, stamparle 
in formato piccolo e non si desidera cambiare 
le dimensioni del file in un secondo tempo.

ANNOTAZIONI FCC:
Questo apparecchio è stato testato e riscontrato conforme ai 
limiti stabiliti per gli apparati digitali di classe B ai sensi della 
Parte 15 delle normative FCC. Tali limiti sono stati fissati 
per fornire una protezione ragionevole contro le interferenze 
dannose nelle installazioni residenziali. Questo apparecchio 
genera, utilizza e può irradiare energia a radiofrequenza e, 
pertanto, se non viene installato e utilizzato in conformità alle 
istruzioni fornite potrebbe interferire con le comunicazioni 
radio. Ciononostante non è possibile garantire l’assenza 
delle interferenze in ciascuna installazione. Se l’apparecchio 
interferisce con la ricezione radiotelevisiva, verificabile 
spegnendolo e riaccendendolo, si consiglia di eliminare 
l’interferenza in uno dei modi seguenti:
· Muovendo o spostando l’antenna ricevente.
· Aumentando la distanza dall’apparecchio al ricevitore.
·  Inserendo l’apparecchio nella presa di un circuito diverso 
da quello in cui è inserito il ricevitore. 

·  Se necessario, rivolgendosi al concessionario o ad un 
tecnico competente.

Utilizzare il cavo interfaccia schermato per soddisfare i limiti 
imposti per i dispositivi digitali ai sensi del sottoparagrafo B 
della Parte 15 delle normative FCC.

Le specifiche e i design sono soggetti a modifica senza 
preavviso e senza assunzione di alcuna obbligazione da parte 
del produttore. 

ridurre



120

Nota:


